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This user manual has been specially designed to 
guide you through the functions and features of 
your device. To get started quickly, refer to the 

Quick Start Guide.
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g
 messaging functions. For 
n entering text, see the Quick Start 

ultimedia message
ome screen, press <Start> → 
ing → SMS/MMS.

enu> → New → SMS/MMS.
estination number or press 
 → Add Recipients to select a 

enu> → Add Field → Subject.
es>.
essage subject.

wn and enter your message text.
2

communication
Your device allows you to send and receive many 

types of calls and messages over cellular networks 
and the internet.

Messagin
Learn to use
instructions o
Guide.

Send a m
1. On the H

Messag
2. Press <M
3. Enter a d

<Menu>
contact.

4. Press <M
5. Press <Y
6. Enter a m
7. Scroll do
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com
m

unication
ally set up an email account, clear 

ck box next to Try to get e-mail 
 automatically from the Internet.

Next>.
he predefined email provider and 
Next>.
ur name and account name, and 
Next>.
e incoming mail server, select the 
t type, and press <Next>.
user name and press <Next>.
e outgoing mail server and press 
.
 often your device connects to the 
nd checks for incoming email 
es in Automatic Send/Receive  
sary).
Finish>.
8. To attach an existing multimedia object, 
press <Menu> → Attach → an object type.
To insert a multimedia object, press 
<Menu> → Add → an object type.

9. Press <Send> to send the message.

Create an email account
Before you can send or receive email 
messages, you must create an email account.

1. On the Home screen, press <Start> → 
Messaging → New Email Account...
To easily create an email account, press 
<Start> → <More> → Internet Services → 

Email Wizard.
2. Enter your email address and password, 

and press <Next>.

3. To manu
the che
settings

4. Press <
5. Select t

press <
6. Enter yo

press <
7. Enter th

accoun
8. Enter a 
9. Enter th

<Next>
10. Set how

server a
messag
(if neces

11. Press <



email from an email server
retrieve email from an internet 
ider or VPN connection, you must 
ail account. 

essages from your Outlook 
e "Synchronise your data."  p. 28

Home screen, press <Start> → 

ing.
he name of an email account.
Menu> → Send/Receive.

sages
ess message folders for your text 
dia messages in one location, and 
ssages.
4

com
m

unication

Send an email message
1. On the Home screen, press <Start> → 

Messaging.
2. Select the name of an email account.
3. Press <Menu> → New.
4. Enter an email address in the To field or 

press <Menu> → Add Recipient to select 
a contact.

5. Scroll down and enter a message subject.
6. Scroll down and enter your message text.
7. To add an attachment, press <Menu> → 

Insert → an attachment type.
8. Press <Send> to send the message.

Retrieve 
Before you 
service prov
create an em

To retrieve m
account, se

1. On the 
Messag

2. Select t
3. Press <

View mes
You can acc
and multime
for email me
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com
m

unication
 an attachment, 

m an open email, scroll to the 
chment and press the Confirm key.
ss the Confirm key → <Open> to open 
 attachment.
 attachment opens with the 
responding application.
 an attachment,

m an open email, scroll to the 
chment and press the Confirm key to 
nload.

ss the Confirm key → <Open> to open 
 attachment.
ss <Menu> → Save As...
 a file name and memory location and 
ss <Save>. 
To view messages,

1. On the Home screen, press <Start> → 
Messaging.

2. Select SMS/MMS or the name of an email 
account.
The Inbox for the account you selected will 
open.

3. To download the complete contents of 
email, select an email from the list or press 
<Menu> → Download Message.

View or save email attachments

To view

1. Fro
atta

2. Pre
the
The
cor

To save

1. Fro
atta
dow

2. Pre
the

3. Pre
4. Set

pre

Email attachments may contain viruses that 
can damage your device. To protect your 
device, open attachments only if you trust 
the sender.



 Manager
ts Manager, you can view and 
e files and folders on your device.

oto
ome screen, press <Start> → 
 → Contents Manager → My 
 → Photo.
a photo thumbnail and press the 
key to open it.
 photos, you can perform the 

ctions:

hrough your photos, scroll left or 

press the Confirm key and then 
left softkey or right softkey. To exit 
screen, press [C].
 picture, press <Menu> → Edit 
6

the zoom 
• To edit the

Image.
media
Learn to use Contents Manager, FM Radio, 

Streaming Player, Adobe® Flash® Lite™, and 
 Voice Notes.

Contents
With Conten
access all th

View a ph
1. On the H

<More>
Pictures

2. Scroll to 
Confirm 

While viewing
following fun

• To scroll t
right.

• To zoom, 
press the 
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m
edia

ome screen, press <Start> → 
 → Contents Manager.
nd open the folder where the file is 

file.
enu> → Send → a sending 

d as a multimedia message, 
 as MMS. See "Send a multimedia 
ge."  p. 2
d as an email message, select as 

. See "Send an email message."  

d via the Bluetooth wireless 
e, select via Bluetooth. See "Use 
uetooth wireless feature."  p. 24
• To set a photo as a background or caller ID 
image, press <Menu> → Set as → an 
option.

• To view your photos as a slideshow, press 
<Menu> → Play Slide Show.

Play a video
1. On the Home screen, press <Start> → 

<More> → Contents Manager → My 
Videos → Video.

2. Scroll to a video thumbnail and press the 
Confirm key to open it.

Open documents
1. On the Home screen, press <Start> → 

<More> → Contents Manager.
2. Locate and open the folder where the 

document is stored.
3. Scroll to the document and press the 

Confirm key to open it.

Send a file
1. On the H

<More>
2. Locate a

stored.
3. Select a 
4. Press <M

option.
• To sen

select
messa

• To sen
Email

 p. 4
• To sen

featur
the Bl



vourites list,

dio screen, scroll left or right to 
dio station you want.

o scroll up or down to the radio 
want from the Channel list 

 as favourite> or press 
 Set as favourite.
.

Player
reaming files on the web.

e screen, press <Start> → 
Internet Services → 
Player.
n>.
 address of the streaming file 
Connect>.
ect a URL address on the 
ry list.
8

m
edia

FM Radio
You can listen to your favourite stations with the 
FM radio.

Listen to the FM radio
1. Plug a headset into the multifunction jack.
2. On the Home screen, press <Start> → 

<More> → FM Radio.
3. Scroll left or right to scan through available 

radio stations.
4. To adjust the volume level, press the 

Navigation key up or down.
To switch sound output to the speaker, 
press <Menu> → Active loudspeaker.

Store radio stations
To save radio stations automatically,

From the radio screen, press <Menu> → 
Channel list → <Scan>.

The radio scans and saves available stations 
automatically.

To set up the Fa

1. From the ra
select the ra
You can als
station you 
screen.

2. Press <Set
<Menu> →

3. Press <OK>

Streaming 
You can play st

1. On the Hom
<More> → 
Streaming 

2. Press <Ope
3. Enter a URL

and press <
You can sel
recent histo
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m
edia

otes
 Voice Notes to record and play 

memos and sound clips.

 voice clip
Home screen, press <Start> → 
tions → Organizer → Voice 

Record> to begin the recording.
ou are finished recording, press 
.
e clip is automatically saved.

ice clip
Home screen, press <Start> → 
tions → Organizer → Voice 

 a voice clip and press the Confirm 

back begins automatically.
Adobe® Flash® Lite™
Your device includes the flash player for viewing 
Flash (swf) files.

To view a Flash file,

1. On the Home screen, press <Start> → 
Applications → Accessories → Adobe 
Flash Lite.

2. Locate and open a folder where the Flash 
file is stored.

3. Scroll to the Flash file and press the 
Confirm key.

Voice N
You can use
back voice 

Record a
1. On the 

Applica
Notes.

2. Press <
3. When y

<Stop>
The voic

Play a vo
1. On the 

Applica
Notes.

2. Scroll to
key.
The play

Adobe Flash Lite 2.1 supports contents 
developed for Flash 7. Depending on the file 
size and memory capacity, some of the Flash 
files may not be opened on your device.



 contact cards to store personal 
uch as names, phone numbers, 

es.

tact cards
y your contact cards from your 
r SIM card and vice versa. When 

 Outlook contact to your SIM card, 
 store the contact’s name and 
er. 

ome screen, press <Start> → 
s.
a contact card, press <Menu> → 
ntact → To Contacts or To SIM.
e contact information, synchronise 
 contacts with a PC (see 
 your data"  p. 28).
10

your Outlook
"Synchronise
personal 
productivity

Learn to use Contacts, Calendar, Office Mobile, 
Adobe Reader LE, Team manager, File Manager, 

and Tasks.

Contacts
Learn to use
information, s
and address

Copy con
You can cop
device to you
you copy an
you can only
phone numb

1. On the H
Contact

2. To copy 
Copy Co

To retain all th
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personal productivity
n a ringtone, scroll to Custom ring 
d scroll left or right to select a 
.
n an image, scroll to Picture and 
ht to select an image.
ou are finished, press <Done>.

r
ar to keep track of appointments, 
r other events.

 calendar event
Home screen, press <Start> → 
ar.
Menu> → New Appointment.
te the fields and adjust the settings 
 event.
ou are finished, press <Done>.
Assign a speed dial number to a 
contact card
1. On the Home screen, press <Start> → 

Contacts.
2. Scroll to a contact card and press the 

Confirm key.
3. Press <Menu> → Add to Speed Dial.
4. Scroll left or right to set a speed dial 

number in the keypad assignment field (if 
necessary).

5. When you are finished, press <Done>.

Assign an image or a ringtone to a 
contact card
1. On the Home screen, press <Start> → 

Contacts to use Outlook contact.
2. Scroll to a contact card.
3. Press <Menu> → Edit.

4. To assig
tone an
ringtone

5. To assig
scroll rig

6. When y

Calenda
Use Calend
birthdays, o

Create a
1. On the 

Calend
2. Press <
3. Comple

for your
4. When y



 edit an Excel workbook
 view an Excel workbook,

ome screen, press <Start> → 
obile → Excel Mobile.
n Excel file and select the file name 
t.
 in or out on part of a document, 
y softkey → <View> → Zoom → a 
tion.
the workbook, press <Menu> → 
le.
cel workbook,

ome screen, press <Start> → 
obile → Excel Mobile.
n Excel file and select the file name 
t.
y softkey → <Menu> → Edit.
a cell and press the Confirm key to 

es or text and press <Done>.
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personal productivity

Change the calendar view
1. On the Home screen, press <Start> → 

Calendar.
2. Press the left softkey to change the 

calender view.

Stop an event alarm
When the alarm sounds for a calendar event 
you set previously, press <Dismiss>.

Office Mobile
With Office Mobile, you can open and edit 
Word, Excel, and PowerPoint files on your 
device. Your device supports files created with 
Office 97 and newer versions.

Open and
To open and

1. On the H
Office M

2. Locate a
to open i

3. To zoom
press an
zoom op

4. To close 
Close Fi

To edit an Ex

1. On the H
Office M

2. Locate a
to open i

3. Press an
4. Scroll to 

select it.
5. Enter valu
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personal productivity
rd document,

ome screen, press <Start> → 
obile → Word Mobile.
 Word file and select the file name 
t.
enu> → Edit.

your document.
e the format, press <Menu> → 
 a type.

he document, press <Menu> → 
ve As...

le name and select the memory 
nd press <Save>.
6. Repeat steps 4-5 as necessary.
7. To save the workbook, press <Menu> → 

File → Save As...
8. Enter a file name and select the memory 

location and press <Save>.

Open and edit a Word document
To open and view a Word document,

1. On the Home screen, press <Start> → 
Office Mobile → Word Mobile.

2. Locate a Word file and select the file name 
to open it.

3. To zoom in or out on part of a document, 
press <View> → a zoom option.

4. To close the workbook, press <Menu> → 
Close File.

To edit a Wo

1. On the H
Office M

2. Locate a
to open i

3. Press <M
4. Change 
5. To chang

Format →
6. To save t

File → Sa
7. Enter a fi

location a



res or voice memos, press 
 Insert Picture or Insert 

 note, press <Done>.

ader LE
der LE, you can open and view 

s.

e screen, press <Start> → 
s → Document Viewer → 
der LE.
n>.
F file and select the file name to 

or out on part of a document, 
ls> → Zoom → a zoom option.
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personal productivity

Open and view a PowerPoint 
slideshow
1. On the Home screen, press <Start> → 

Office Mobile → PowerPoint Mobile.
2. Locate a PowerPoint file and select the file 

name to open it.
3. To begin the slideshow, press any softkey 

→ <Menu> → Custom Show.
4. To end the slideshow, press <End>.

Create and edit a note
1. On the Home screen, press <Start> → 

Office Mobile → OneNote Mobile.
2. Press <New>.
3. Create your note.
4. To change the format, press <Menu> → 

Format → a type. 
To clear all formatting, press <Menu> → 
Format → Clear All.

5. To add pictu
<Menu> →
Recording.

6. To save the

Adobe® Re
With Adobe Rea
PDF document

1. On the Hom
Application
Adobe Rea

2. Press <Ope
3. Locate a PD

open it.
4. To zoom in 

press <Too
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personal productivity
ssage to members

ome screen, press <Start> → 
→ <More> → Team manager.
 team.
enu> → Send → a message 

umber for a contact (if 
y).
 message text.
end> to send the message.

ppointment
ome screen, press <Start> → 
→ <More> → Team manager.
 team.
enu> → Set appointment.
ointment details.

u are finished, press <Done>.
wn and enter the message text.
end> to send the message.
Team manager
With Team manager, you can make a team with 
members and send a message to them at the 
same time.

Make a new team
1. On the Home screen, press <Start> → 

<More> → <More> → Team manager.
2. Press <New>.
3. Enter team details.
4. When you are finished, press <Done>.

Add members to a team
1. On the Home screen, press <Start> → 

<More> → <More> → Team manager → 

a team.
2. Press <Add>.
3. Select contacts and press <Done>.

Send a me
1. On the H

<More> 
2. Scroll to a
3. Press <M

type.
4. Select a n

necessar
5. Enter the
6. Press <S

Send an a
1. On the H

<More> 
2. Scroll to a
3. Press <M
4. Enter app
5. When yo
6. Scroll do
7. Press <S



k as completed
ve completed a task, return to the 
 and scroll to the task name, and 
plete>. Once you have marked a 
ed, you will no longer receive any 
minders for that task.
16

personal productivity

File Manager
With File Manager, you can browse all the files 
and folders on your device. On the Home 
screen, press <Start> → Applications → File 
Manager.
Press <Menu> to rename, delete, or edit your 
files and folders.

Tasks
With Tasks, you can create to-do lists and 
reminders.

Create a task
1. On the Home screen, press <Start> → 

Applications → Organizer → Tasks.
2. Press <Menu> → New Task. 
3. Enter details for the task.
4. When you are finished, press <Done>.

Mark a tas
When you ha
Tasks screen
press <Com
task complet
scheduled re
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xplorer
Explorer to browse web pages and 
ur favourite web pages.

web page
ome screen, press <Start> → 
Explorer.
 web page:

 <Menu> → Favourites and select 
kmark.
 <Menu> → Address Bar to enter 
 address and press <Go>.
 <Menu> → History to select a 
ddress from the history list.
web
Learn to use Internet Explorer, Windows Live, 

Messenger, RSS Reader, Podcast, Vodafone Links, 
and Business Mail.

Internet E
Use Internet 
bookmark yo

Browse a 
1. On the H

Internet 
2. Access a

• Press
a boo

• Press
a web

• Press
web a



e the folder under which you want to 
e bookmark (if necessary).

Add>.

browser settings
rowser, press <Menu> → Tools → 

l: set sound and display settings for 
ser
age: set a web address for 
ge
tions: configure connection settings

y: view information about the 
 currently in use for temporary files, 
, and history
18

w
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3. To close the web connection, on the Home 
screen, press <Start> → Applications → 
Accessories → Data Call Manager. Scroll 
to the connection you want to end and 
press <OK>.

Add a bookmark
1. On the Home screen, press <Start> → 

Internet Explorer.
2. Access a web page you want and press 

<Menu> → Add to Favourites.
3. Enter the bookmark name and address (if 

necessary).

4. Chang
add th

5. Press <

Change 
From the b
Options:

• Genera
the brow

• Home P
homepa

• Connec
• Memor

memory
cookies

To confirm that the connection is ended, 
press [ ] → Wireless Manager → 
Phone → the Confirm key to disable 
wireless functions. Press the Confirm 
key again to enable the wireless 
functions.
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w
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ssenger and sign in
ome screen, press <Start> → 
 → Internet Services → 
er.

 or right to select your login status.
ign in>.

 Messenger
 messenger screen, locate and 
contact’s name, and then press 

>.
essage in the text field at the 
f the screen, and then press 
.

Windows Live
With Windows Live, you can stay in touch with 
friends and access information on the wireless 
web quickly.

1. On the Home screen, press <Start> → 
<More> → Internet Services → Windows 
Live.

2. Scroll to Sign in to Windows Live and 
press the Confirm key.

3. Follow the on-screen instructions.

Messenger
With Windows Live Messenger, you can remain 
available to other users and stay up-to-date 
with your email without a constant connection 
to the internet. When a new message arrives or 
you want to access internet services, the 
connection will be restored.

Set up Me
1. On the H

<More>
Messeng

2. Scroll left
3. Press <S

Chat with
1. From the

select a 
<Send IM

2. Enter a m
bottom o
<Send>



der
RSS reader to get the latest news 
on from your favourite websites.

ds
ome screen, press <Start> → 
→ Internet Services → RSS 

enu> → Edit → New folder (if 
y).
enu> → Edit → New feed.

 address of a RSS feed and select 
 under which you want to add the 
 and press <OK>.
20
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3. While chatting, you can perform the 
following actions:
• Insert emoticons: press <Menu> → Add 

emoticon
• Invite a contact to chat: press <Menu> 

→ Options → Add participant
• Transfer a file: press <Menu> → Send → 

a file type → a file
• Record and send a voice clip: select 

Voice clip, record your voice clip, and 
then press <Send>

• Switch between the contact list and 
chat: scroll left or right

4. To end the chat, press <Menu> → End 
conversation.

RSS Rea
Learn to use 
and informati

Create fee
1. On the H

<More> 
Reader.

2. Press <M
necessar

3. Press <M
4. Enter the

the folder
RSS feed
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feeds
ome screen, press <Start> → 
 → Internet Services → RSS 

enu> → Feed search.
eyword and press <Search>.
ice searches for related feeds on 
et and displays the results.
the feed and press <Add> to add 
SS feed list.

t to download audio or video files 
nd play them on your device.

 to a podcast
ome screen, press <Start> → 
 → Internet Services → Podcast 
sts. 
enu> → Subscribe to Podcast.
Import feeds
You can add feeds by importing OPML files.

1. On the Home screen, press <Start> → 
<More> → Internet Services → RSS 
Reader.

2. Press <Menu> → OPML → Import → 

Select OPML file or Enter OPML URL.
3. Locate an OPML file or enter the address of 

an OPML URL.

Read RSS feeds
1. On the Home screen, press <Start> → 

<More> → Internet Services → RSS 
Reader.

2. Scroll to a feed and press <Update> to get 
the latest contents.

3. When the update is finished, press 
<Done>.

4. Press the Confirm key to select an updated 
feed.

Find new 
1. On the H

<More>
Reader.

2. Press <M
3. Enter a k

Your dev
the intern

4. Scroll to 
it to the R

Podcast
Use Podcas
from a web a

Subscribe
1. On the H

<More>
→ Podca

2. Press <M



 and play a podcast
ome screen, press <Start> → 
 → Internet Services → Podcast 
sts.

a podcast and press <Get> to 
d it.
ast automatically plays in 
 Media Player.

 Links
 a variety of customer services and 
y your service provider. For details, 
 service provider.

 screen, press <Start> → 
nternet Services → <More> → 
nks → a link.

one Links may not be available 
ding on your region.
22

w
eb

3. Enter a web address (URL) and press 
<Subscribe> → <Yes>.

4. Follow the on-screen instructions to 
complete the setup.

Search for a podcast
1. On the Home screen, press <Start> → 

<More> → Internet Services → Podcast 
→ Podcasts.

2. Press <Menu> → Search Podcast.
3. Enter a keyword and press <Search>.

Your device searches for related reports on 
the internet and displays the results.

4. Scroll to the report and press <Add> to 
add it to the podcast list.

Download
1. On the H

<More>
→ Podca

2. Scroll to 
downloa
The podc
Windows

Vodafone
Learn to use
information b
contact your

On the Home
<More> → I
Vodafone Li

Vodaf
depen
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eb
Business Mail
With Business Mail, receive emails that are 
transferred from your email server to your 
device. Business Mail provides secure, wireless 
synchronisation of your email, calendar, and 
contacts.

To set up your mailbox,

1. On the Home screen, press <Start> → 
<More> → Business Mail.

2. Follow the on-screen instructions to set up 
an online mailbox.
For more details, contact your service 
provider.

Business Mail may not be available 
depending on your region.



luetooth wireless 

nect with other Bluetooth-enabled 
ces over a distance of 10 metres 
lls or other obstacles between 
 block or impair the wireless 

e Bluetooth wireless 

ome screen, press <Start> → 
 → More... → Connections → 
h → General Settings.
enu> → Turn On Bluetooth.

other devices to find and connect 
evice, press <Menu> → Turn On 
.
one>.
24

Visibility
4. Press <D
connectivity
Learn to transfer data to and from your device via 

the Bluetooth wireless feature or the PC data cable 
and synchronise your device to a computer with 

ActiveSync. Learn to set up data or network 
connections for connecting to the internet or your 

private network.

Use the B
feature
You can con
wireless devi
(30 feet). Wa
devices may
connection.

Turn on th
feature
1. On the H

Settings
Bluetoot

2. Press <M
3. To allow 

to your d
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connectivity
 via the Bluetooth 
ature

n item or file to send.
enu> → Send → via Bluetooth 

u> → Send Contact → Beam.
device from the list.

ata via the Bluetooth 
ature

ome screen, press <Start> → 
 → More... → Connections → 

e check box next to Receive 
g beams.
one>.
Search for and pair with a 
Bluetooth-enabled device
1. On the Home screen, press <Start> → 

Settings → More... → Connections → 
Bluetooth → General Settings.

2. Select Add new device...

Your device will search for and display the 
list of Bluetooth-enabled devices.

3. Scroll to a device and press <Next>.
4. Enter the Bluetooth PIN and press <Next>.

5. Press <Done>.

Send data
wireless fe
1. Locate a
2. Press <M

or <Men
3. Select a 

Receive d
wireless fe
1. On the H

Settings
Beam.

2. Select th
incomin

3. Press <D

To pair with another Bluetooth enabled 
device, both devices must use the same 
PIN. Headsets or hands-free car kit may 
use a fixed PIN, such as 0000.



 via USB

ult action for your USB 
n
evice to perform a default action 
nnect the device to a PC with the 
le,

ome screen, press <Start> → 
 → More... → Connections → 

efault USB mode (ActiveSync or 
rage).
one>.
Sync, see "Synchronise your 
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Set up a Bluetooth COM port
When you connect to a Bluetooth device 
supporting the Serial profile, you can establish a 
Bluetooth COM port.

1. On the Home screen, press <Start> → 
Settings → More... → Connections → 
Bluetooth → General Settings.

2. Press <Menu> → COM Ports → <Menu> 
→ New Outgoing Port.

3. Select the name of a device and press 
<Select>.

4. Select a COM port.
5. Select the check box next to Secure 

Connection to create a secure connection 
between the devices.

6. Press <Done>.

Connect

Set a defa
connectio
To set your d
when you co
PC data cab

1. On the H
Settings
USB.

2. Set the d
Mass sto

3. Press <D
To use Active
device."
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ise your device

ync, you can synchronise your 
 computer and back up and 
data.

iveSync on your computer
an synchronise your data, you 
ctiveSync, either from the supplied 
the Microsoft website (http://
ft.com). 

iveSync from the supplied  

 CD-ROM into your PC.
e on-screen instructions to 
 the setup.
tallation is complete, follow the 
n instructions in the 
ization Setup Wizard to connect 

ice to the PC and create a data 
artnership.
Copy files to a memory card
1. Insert a memory card into the device.
2. Change the USB connection to Mass 

storage.
3. Connect your device to a PC with the PC 

data cable.
4. Open a folder to view files.
5. Copy files to the memory card and vice 

versa.
6. When you are finished, disconnect the 

device from the PC.

Synchron
With ActiveS
device with a
restore your 

Install Act
Before you c
must install A
CD-ROM or 
www.microso

To install Act
CD-ROM,

1. Insert the
2. Follow th

complete
3. When ins

on-scree
Synchron
your dev
sharing p



 manually find and copy files from 
o a PC and vice versa—from the 
tiveSync window, click Explore.

ails on synchronising your data, 
ctiveSync Help.

 an Exchange server
ome screen, press <Start> → 
ions → ActiveSync.
enu> → Configure Server. If you 

 yet set up the synchronisation with 
nge server, this will say Add 
ource.
r email address and press 

erver address.
lish a secure connection, select 
k box next to This server requires 
pted (SSL) connection.
ext>.
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Connect your device to a computer 
with the PC data cable
1. On the Home screen, press <Start> → 

Settings → More... → Connections → 
USB.

2. Change the USB connection to 
ActiveSync and press <Done>.

3. Connect one end of the PC data cable to 
the multifunction jack on your device and 
the other end to the USB port on your PC.

Synchronise your data
When you connect your device to a PC, 
ActiveSync should begin synchronising your 
data automatically. You can begin the 
synchronisation manually by clicking Sync. To 
stop a synchronisation in progress, click Stop.

You can also
your device t
Microsoft Ac

For more det
refer to the A

Configure
1. On the H

Applicat
2. Press <M

have not
an Excha
Server S

3. Enter you
<Next>.

4. Enter a s
5. To estab

the chec
an encry

6. Press <N
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bove settings when roaming: 
 use the synchronisation 
ules even when roaming
/receive when I click Send: set to 
ronise each time you send or 
e email
u are finished, press <Done>.

ernet connection with a 

your device as a wireless modem 
 access the internet from the PC.

 your device to a PC with the PC 
le or with the Bluetooth wireless 

ome screen, press <Start> → 

 → Internet Services → Internet 
7. Enter a user name, password, and domain 
address.

8. Press <Next>.
9. Select the types of data to synchronise.
10. When you are finished, press <Finish>.

Change the synchronisation 
schedule
If you routinely synchronise your data via an 
Exchange server, you can configure settings for 
both peak and off-peak schedules. 

To change the synchronisation schedules,

1. Press <Menu> → Schedule.
2. Set the following options:

• Peak times: set the frequency of 
synchronisations during peak hours

• Off-peak times: set the frequency of 
synchronisations during non-peak hours

• Use a
set to
sched

• Send
synch
receiv

3. When yo

Share int
PC
You can set 
for a PC and

1. Connect
data cab
feature.

2. On the H
<More>
Sharing.



 Internet service provider (ISP) or 
ervice provider: ISP server phone 
r access point, user name, and 
.

l-up connections
ome screen, press <Start> → 
 → More... → Connections → 

enu> → Add to add a new 
on.
onnection information (see "Dial-
etails  p. 41).
u are finished, press <Done>.

evice should already be configured 
ternet access. If you have trouble 
sing the internet, you need to edit 
ctions. If you are not sure about the 
ation to enter, ask your service 
er.
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3. Select the PC connection and network 
connection type, and then press 
<Connect>.

Connect to the internet or your  
private network
To connect to the internet or your network and 
transfer data, create data and network 
connections. 

Before you begin, obtain the following 
information:

• From your cellular network service provider: 
data connectivity plan information, server 
phone number, user name, and password.

• From your
wireless s
number o
password

Set up dia
1. On the H

Settings
Dial-up.

2. Press <M
connecti

3. Set the c
up" for d

4. When yo

While you are connected to the internet 
via Internet Sharing, ActiveSync is 
deactivated.

Your d
with in
acces
conne
inform
provid
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N server connections
ome screen, press <Start> → 
 → More... → Connections → 

 VPN.
enu> → Add to add a new 

on.
onnection information (see "VPN" 
  p. 43).

u are finished, press <Done>.
Set up GPRS connections
1. On the Home screen, press <Start> → 

Settings → More... → Connections → 
GPRS.

2. Press <Menu> → Add to add a new 
connection.

3. Set the connection information (see 
"GPRS" for details  p. 42).

4. When you are finished, press <Done>.

Set up proxy server connections
1. On the Home screen, press <Start> → 

Settings → More... → Connections → 
More... → Proxy.

2. Press <Menu> → Add to add a new 
connection.

3. Set the connection information (see "Proxy" 
for details  p. 42).

4. When you are finished, press <Done>.

Set up VP
1. On the H

Settings
More... →

2. Press <M
connecti

3. Set the c
for details

4. When yo



s,

ome screen, press <Start> →  
 → Entertainment.
game from the list and follow the 
n instructions.

er where downloaded games and 
are stored.

 applications
ome screen, press <Start> → 
 → Entertainment → Java.
ownload>.

le games may vary, depending on 
ervice provider or region. Game 
ls and options may vary.
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1. On the H
<More>

2. Press <D
additional 
programs

Learn to use Games, Java, World Clock, Alarms, 
D-Day, Calculator, Smart Converter, and 

StopWatch.

Games
To play game

1. On the H
<More>

2. Select a 
on-scree

Java
Java is a fold
applications 

Download

Availab
your s
contro



33

additional program
s

 or down to select a country and 

one>.
ylight saving time, press <Menu> 
 DST.

rld clock to your display
 clocks with two different time 
r display.

e created a world clock,

ome screen, press <Start> → 
ions → Organizer → World 

the world clock you want to add.
enu> → Set as home screen.
K>.
Launch applications
1. On the Home screen, press <Start> → 

<More> → Entertainment → Java → an 
application.

2. Press <Menu> to access a list of various 
options and settings for your application.

World Clock
With a world clock, you can monitor the time in 
another city or country.

Create a world clock
1. On the Home screen, press <Start> → 

Applications → Organizer → World 
Clock.

2. Scroll to a world clock and press 
<Assign>.

3. Scroll left or right to select a time zone.

4. Scroll up
city.

5. Press <D
6. To set da

→ Apply

Add a wo
You can view
zones on you

After you hav

1. On the H
Applicat
Clock.

2. Scroll to 
3. Press <M
4. Press <O



 calculate how many days are left 
e passed since a specific event.

ome screen, press <Start> → 
ions → Organizer → D-Day → 

 details of the counter in each field.
u are finished, press <Done>.

r
ome screen, press <Start> → 
ions → Accessories → 

or.
keys that correspond to the 
r display to perform basic 
tical operations.
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Alarms
Learn to set and control alarms for important 
events.

Set a new alarm
1. On the Home screen, press <Start> → 

Applications → Organizer → Alarms.
2. Scroll to an empty alarm location and press 

<Edit>.
3. Set alarm details.
4. When you are finished, press <Done>.

Stop an alarm
When the alarm sounds,

• Press <Ok> to stop an alarm without 
snooze.

• Press <Dismiss> to stop an alarm with 
snooze or press <Snooze> to silence the 
alarm for the snooze period.

D-Day
Use D-Day to
before or hav

1. On the H
Applicat
<New>.

2. Enter the
3. When yo

Calculato
1. On the H

Applicat
Calculat

2. Use the 
calculato
mathema
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ch
ome screen, press <Start> → 
ions → Accessories → 
tch.
tart> to begin the stopwatch.
ecord> to record lap times.
u are finished, press <Stop>.
eset> to clear recorded times.
Smart Converter
With Smart Converter, you can convert 
measurements or currencies from one unit to 
another.

1. On the Home screen, press <Start> → 
Applications → Accessories → Smart 
Converter.

2. Select the type of measurement.
3. Scroll left or right to change the base unit (if 

necessary).
4. Scroll down and enter the base amount.
5. Scroll down and scroll left or right to change 

the conversion unit (if necessary).
The device displays the conversion result.

StopWat
1. On the H

Applicat
StopWa

2. Press <S
3. Press <R
4. When yo
5. Press <R



your device settings. To access 
ettings, 

 screen, press <Start> → 

your device handles calls with 
 waiting, and other call settings.

ection: set to operate your device 
 or GSM networks

: view the cost of calls, if supported 
IM or USIM card

ns 
nswer: set to answer a call when 
 any key (except [ ] and [ ])
 contacts: set to show contact 

ed on the SIM or USIM card

ess more setting options, scroll down 
ct More...
36

Any key a
you press
Show SIM
cards stor
Settings
Learn about 
your device s

On the Home
Settings.

Phone
Control how 
caller ID, call

All Calls
• Band Sel

on UMTS

• Call Cost
by your S

• Call Optio

To acc
or sele
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etwork: view the current network
selection: set the device to 
ally or manually select a list of 
tworks

ser Group: set the device to 
lls to and from a selected group of 

ng: restrict incoming or outgoing 

oming calls
 to deactivate incoming call barring
oaming: set to prevent incoming 
en you are outside your home 

 area
: set to prevent all incoming calls

receive service on another network, 
 must select one that has a roaming 
eement with your home network.
Phone number: view your phone number
Voice mail number: set the voice mail 
number provided by your service provider
Text messages service centre: set the text 
message service number provided by your 
service provider
Country code: set your country code
Dialling code: set your area code

• Caller ID: set to send your caller ID based 
on your preferences or network settings

• Channels
Enable channels: set to receive cell 
broadcast messages
Receive channel list: set to receive a list of 
all available broadcast channels from the 
network
Language: set your preferred languages to 
display cell broadcast messages

• Fixed Dialling: set to allow outgoing calls 
only to the limited set of phone numbers

• Networks
Current n
Network 
automatic
cellular ne

• Closed U
restrict ca
users

Voice Calls
• Call Barri

calls
Block inc
- Off: set
- When r

calls wh
service

- All calls

To 
you
agr



 Image: set an image to use 
ideo call

ptions: set the device to retry the 
or send a text message when a 
is not connected

ng: restrict incoming or outgoing 

arding: divert incoming calls to 
umber

ers
one number on the SIM or USIM 

ved number does not affect the 
riber phone number of your SIM or 
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Block outgoing calls
- Off: set to deactivate outgoing call barring
- Int’l calls except to home: set to prevent 

international calls to countries other than 
your home country

- Int’l calls: set to prevent calls to 
international numbers

- All calls: set to prevent all outgoing calls

• Call Forwarding: divert incoming calls to 
another number
Unconditional: set to divert all voice calls
No Reply: set to divert calls when you do 
not answer
Busy: set to divert calls when you are on 
another call
Unavailable: set to divert calls when your 
device is off
Data Calls: set to prevent all data calls

• Call Waiting: set to alert you of an incoming 
call while you are on a call

Video Calls
• Outgoing

during a v

• Call Fail O
video call 
voice call 

• Call Barri
calls

• Call Forw
another n

Own Numb
Save your ph
card. The sa
actual subsc
USIM card.
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set one of the following DNSe (Digital 
Sound Engine) options to enrich your 
t’s digital sound effect:
nd: set a 3D sound effect
de: set an equaliser effect
: set an echoing effect 

reen
screen layout: set a layout for the 
creen

ecent Programs: set to display the 
 Programs screen when you press 

 scheme: set a skin colour

ound image: set a wallpaper

ut: set the time delay before the 
screen switches to the Home screen
Sounds
• Ring Tone: set a ringtone for incoming calls

• Notification
Reminders: set a tone for reminders
New email: set a tone for incoming email 
messages
New text message: set a tone for incoming 
text messages
New voice message: set a tone for 
incoming voice mails
New instant message: set a tone for 
incoming instant messages
SIM toolkit messages: set a tone for 
incoming SIM toolkit messages

• System Sound
Exclamation: set a tone for exclamations
Question: set a tone for questions
Warnings: set the device to sound a 
warning tone (e.g., when the battery is low)

• Keypad Tone: set a tone for your key press

• DNSe: 
Natural 
headse
3D Sou
EQ Mo
Reverb

Display

Home Sc
• Home 

Home s

• Show R
Recent
<Start>

• Colour
• Backgr
• Time o

current 



ettings
: set a display language (for all 

d applications)

et your region

e style: set a date format

e style: set a date format

at: set a time format

umber: set how you want positive 
displayed

 number: set how you want 
umbers displayed

urrency: set how you want 
urrency displayed

 currency: set how you want 
urrency displayed
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Profiles
Change the sound profile (see the Quick Start 
Guide). 

Date and Time
Control the appearance and behavior of the 
date and time.

• Time zone: set the time zone

• Date: set the current date

• Time: set the current time

• Time zone updating: select a mode for 
updating the current time and date
Manual only: set the time and date 
manually
Prompt first: the device will ask you if you 
want to update time information
Automatic: Your device will receive time 
information from the network and 
automatically update the current time. This 
option is available only if supported by your 
network.

Regional S
• Language

menus an

• Locale: s

• Short dat
• Long dat
• Time form
• Positive n

numbers 

• Negative
negative n

• Positive c
positive c

• Negative
negative c
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ettings: change the OBEX settings 
to receiving files

rmation Settings: check your 
 name and address

w your device behaves when you 
to a PC.

ial-up connections, press <Menu> 
ccess the following options:

tion: set a name for the dial-up 
tion

ts to: set a network type to use to 
t to the internet

number: enter your phone number

nce the default Bluetooth printer is 
elected, you can print images from 
ontents Manager.
Connections
Control the Bluetooth wireless feature or USB 
connection and set up dial-up, GPRS, proxy, 
and VPN connections so that you can connect 
to the internet or your private network.

Wireless Manager
Set to disable or enable your device’s wireless 
functions or Bluetooth wireless feature.

Beam
Set the device to receive beams for receiving 
data from other Bluetooth devices.

Bluetooth
• General Settings: control the Bluetooth 

wireless feature (see "Use the Bluetooth 
wireless feature"  p. 24)

• BPP Settings: set a default Bluetooth 
printer when Bluetooth printers are paired 
with your device

• OBEX S
related 

• My Info
device’s

USB
Control ho
connect it 

Dial-up
To set up d
→ Add to a

• Descrip
connec

• Connec
connec

• Phone 

O
s
C



 DNS: set the secondary domain 
er (DNS) address

: enter the gateway IP address 
y your service provider

y connections, press <Menu> → 
s the following options:

n: set a name for the proxy 

from: set a network type to use 
 from

to: set a network type to use to 
 the internet

e:port): set a name and port 
a proxy server

 network type to use to connect 
y server

: set a user name

: set a password for the proxy 
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• User name: set a user name

• Password: set a password for the dial-up 
connection

• Domain: enter the domain name

GPRS
To set up GPRS connections, press <Menu> 
→ Add to access the following options:

• Description: set a name for the GPRS 
connection

• Connects to: set a network type to use to 
connect to the internet

• Access point: set an access point name

• User name: set a user name

• Password: set a password for the GPRS 
connection

• Authentication Type: set an authentication 
type

• Primary DNS: set the primary domain name 
server (DNS) address

• Secondary
name serv

• IP address
provided b

Proxy
To set up prox
Add to acces

• Descriptio
connection

• Connects 
to connect

• Connects 
connect to

• Proxy (nam
number of 

• Type: set a
to the prox

• User name
• Password

connection
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ager
d options for the Assist GPS 
re activating this feature, close all 
ications for the optimal use of the 

ownload updated GPS data

 set options for downloading GPS 

rol
 domain names to your company 

codes and manage security 
r security modules.

ock: set a lock code for the device

IM Lock: set the device use only 
or USIM card; When SIM or USIM 
abled, you are not able to use 
IM or USIM card on your device
VPN
To set up VPN connections, press <Menu> → 
Add to access the following options:

• Description: set a name for the VPN 
connection

• VPN type: set a VPN type

• Server: set a name of the VPN server

• Connects from: set a network type to use 
to connect from

• Connects to: set a network type to use to 
connect to the internet

• User name: set a user name

• Password: set a password for the VPN 
connection

• Domain: set a domain name

• IPSec authentication: set the type of 
authentication if you set the VPN type to 
IPSec/L2TP

• IPSec Pre-shared key: set a pre-shared 
key if you set Pre-Shared Key

Agps Man
Set downloa
feature. Befo
running appl
GPS.

• Status: d

• Settings:
data

Domain En
Register new
resources.

Security
Set security 
certificates o

• Device L
• Enable S

your SIM 
Lock is en
another S



mail
w email account.

 Ticker
y a ticker for new messages. When 

new message, the message 
h the selected image on the screen.

ding Options
 settings for sending text 

 Programs
tory of the program installation.

Programs
grams you have installed on your 
ll to a program and press <Menu> 

.
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• Enable SIM PIN: set the device to request a 
PIN each time you turn it on

• Change SIM PIN: change the PIN

• Change PIN2: change the PIN2

• Certificates: view security certificates. 
These certificates help keep your personal 
data secure and help you avoid viruses and 
other dangerous software

• Change Barring Password: change a call 
barring password

• Change Reset Password: change the 
device password

• Reset: reset settings to their factory defaults

• Mobile Tracker: set the device to send the 
preset tracking message to your family or 
friends when someone tries to use your 
device with another SIM or USIM card. This 
feature may be unavailable due to certain 
features supported by your service provider.

Setup E-
Create a ne

Message
Set to displa
you have a 
appears wit

SMS Sen
Change the
messages.

Managed
View the his

Remove 
Remove pro
device. Scro
→ Remove
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rmation
ct information.

ormation
n about the memory currently in 
ice and a memory card. To 
ry card, press <Menu> → 

ge Card.

e
e’s name.

y
t size: set the text size on the 

 time out: set the delay when 
 key for entering text

n time out: set the delay before 
ed action times out

 volume: set the volume for the 
uring a call
Power Management
• Battery: view the remaining battery

• Backlight time: set the delay before the 
backlight dims

• Display time: set the delay before the 
display dims

• Display Brightness: set the brightness of 
the display

• Keypad light time: set the delay before the 
keypad backlight dims

• Light Sensor: set the device to use the light 
sensor for determining the use of backlight 
and keypad backlight

• Keypad light on: set the keypad backlight 
to turn on (Any time) or set the period for the 
keypad backlight (Custom time) in the 
following options

• Start time: set the starting time for the 
keypad to work

• End time: set the ending time for the 
keypad to work

Owner Info
Set your conta

Memory Inf
View informatio
use on the dev
format a memo
Format Stora

Device Nam
Set your devic

Accessibilit
• System fon

display

• Multipress
you press a

• Confirmatio
an unconfirm

• In-call alert
alert tone d



s Update
evice to download critical and 
lated updates you need from the 
website. Microsoft provides updates 
ws operating system software and 
-based hardware to keep your device 
e and help protect against known 
reats.

ll RO
digital rights that are saved in the 
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About
View your device information.

Error Reporting
Set your device to send an error report to 
Microsoft when an error occurs during software 
operation. This helps Microsoft improve future 
version of products.

Customer Feedback
Set your device to send some feedback about 
how you are using Windows Mobile products. 
This helps identify trends and usage patterns to 
improve future versions of products.

Window
Set your d
security-re
Microsoft 
for Windo
Windows
up-to-dat
security th

Delete a
Delete all 
device.
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you contact a service professional.

e does not show a signal (no 
o the network icon).
turned on the device, wait about 2 
r your device to find the network 
e a signal.
ot be able to receive a signal in 

 elevators. Move to an open area.

Your SIM or USIM card is 
blocked, usually as a result of 
entering your PIN incorrectly 
several times. You must enter 
the PUK supplied by your 
service provider.

Try this to solve the problem:
trouble
If you have trouble

While using yo
following mes

Message Try

SIM Failure
En
ca

Enter SIM 
PIN

Wh
firs
req
mu
the
this
Se
→ 
shooting
 with your device, try these procedures before 

ur device, the 
sages may appear:

Your devic
bars next t
• If you just 

minutes fo
and receiv

• You may n
tunnels or

 this to solve the problem:
sure that the SIM or USIM 
rd is installed correctly.

en using the device for the 
t time or when the PIN 
uirement is enabled, you 
st enter the PIN supplied with 
 SIM or USIM card. To disable 
 feature, press <Start> → 
ttings → More... → Security 
Disable SIM PIN.

PUK 
Required

Message



a contact to call, but the call 
d.

at the correct number is stored in 
t information.
nd save the number, if necessary.

ller cannot hear you 

at you are not blocking the built-in 
e.
built-in microphone closer to your 

headset, ensure that it is properly 
.

 quality of a call is poor.
at you are not blocking internal 

 are in areas with weak signals, 
ose reception. Move to another 
try again.
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• You may be between service areas. You 
should receive a signal when you enter a 
service area.

You forgot a security, PIN, or PUK code.
If you forget or lose this or another code, 
contact the seller or your service provider.

Your display shows white lines.
The display may show white lines if you have 
turned the device on after a long period of 
disuse or if you removed the battery without first 
turning off the device. The display should 
correct itself in a short time.

You enter a number, but the call is not 
dialled.
• Ensure that you have pressed [ ].
• Ensure that you have accessed the right 

cellular network.
• Ensure that you have not set call barring for 

the phone number.

You select 
is not dialle
• Ensure th

the contac
• Re-enter a

Another ca
speaking.
• Ensure th

microphon
• Move the 

mouth.
• If using a 

connected

The sound
• Ensure th

antenna.
• When you

you may l
area and 
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e prompts you to delete 
.
 memory is low. Move your data to 
rd or delete old items from 

e cannot connect to the 

u have entered valid settings for 
et service provider.
u have activated the wireless 
n to your mobile service provider 
he signal is not obstructed.
at you have entered the correct 
 and password.
The battery does not charge properly or 
sometimes your device turns itself off 
while charging.
• Disconnect the device from the charger, 

remove and reinstall the battery, and try 
charging again.

• The battery terminals may be dirty. Wipe 
both gold-coloured contacts with a clean, 
soft cloth and try charging the battery again.

• If the battery no longer charges completely, 
dispose of the old battery properly and 
replace it with a new battery.

Your device is hot to the touch.
When you use several applications at once, 
your device requires more power and may heat 
up. This is normal and should not affect your 
device’s lifespan or performance.

Your devic
some data
The available
a memory ca
applications.

Your devic
internet.
• Ensure yo

your intern
• Ensure yo

connectio
and that t

• Ensure th
user name



t listen to music on a remote 
headset.
at your device is connected to the 

at the music format you are trying 
 is supported by the headset.

at the distance between the 
nd device is not more than 10 
d that they are not separated by 
ther obstacles.
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You cannot find a Bluetooth-enabled 
device.
• Ensure that both devices have activated the 

Bluetooth wireless feature.
• Ensure that the distance between the 

devices is not more than 10 metres and that 
they are not separated by walls or other 
obstacles.

• Ensure that the settings for each device 
allow them to be visible to other devices.

• Ensure that both devices are compatible 
with Bluetooth wireless technology.

• Ensure that the correct PIN has been 
entered on both devices.

You canno
Bluetooth 
• Ensure th

headset.
• Ensure th

to listen to
• Ensure th

headset a
metres an
walls or o



a

s, contacts
assigning images or 
ringtones, 11
assigning speed dial 
numbers, 11
copying contact cards, 10

contents manager, see 
media

date and time, 40

D-Day, 34

display, 39

Exchange server, see 
ActiveSync
inde
ActiveSyn

Exchang
installing
schedu
synchro

Adobe Fla

Adobe Re

alarm
setting, 
stopping

Bluetooth
activatin
COM p
x
c
e server, 28
, 27

le, 29
nise, 28

sh Lite, see media

ader LE, 14

34
, 34

g, 24
ort, 26

connecting to other device
25
receiving data, 25
sending data, 25

calculator, 34

calendar
changing views, 12
creating events, 11
stopping event alarms, 12

certificate, 44

clock
changing world clock, 33
setting alarms, 34
stopping alarms, 34
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4

tasks
creating, 16
marking as completed, 16

team manager, 15

voice notes, see media

wireless manager, 41
b

index

file manager, 16

FM radio
listening to, 8
storing stations, 8

games, 32

Java, 32

language, 40

media
opening files in contents 
manager, 6
playing Flash files, 9
playing voice clips, 9
recording voice clips, 9

messaging
email, 4

multimedia, 2
viewing, 4

messenger
chatting, 19
setting up and signing in,

Office Mobile
Excel workbooks, 12
OneNote, 14
PowerPoint slideshows, 1
Word documents, 13

podcasts, 21, 22, 23

RSS reader, 20

security, 43

sounds, 39

stopwatch, 35
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